# CONTENTS

1 ACCESSING THE APPLICATION ........................................................................................................... 4

2 DISPLAY ........................................................................................................................................... 4

   2.1 Folders view ............................................................................................................................... 5

   2.2 Navigation and search options ................................................................................................. 5

   2.3 Details View ............................................................................................................................. 6

   2.4 Show Full path in the address bar ......................................................................................... 7

   2.5 Highlighting multiple items in Records Explorer ................................................................. 7

      2.5.1 Adjacent records .................................................................................................................. 7

      2.5.2 Non-Adjacent records ........................................................................................................ 7

   2.6 Desktop shortcuts ..................................................................................................................... 8

   2.7 Opening Non-Standard document applications with the TRIM Document VIEWER ............... 8

3 SEARCHING ...................................................................................................................................... 9

   3.1 Initiating a New Search using the “Reset TRIM Search” button ........................................... 9

   3.2 Search Tab ............................................................................................................................... 10

   3.3 Boolean Searching ................................................................................................................... 11

   3.4 Sort Tab .................................................................................................................................... 11

   3.5 Filter Tab ................................................................................................................................... 11

   3.6 Record Types Tab ..................................................................................................................... 12

   3.7 Modifying a search using “TRIM Search” button ................................................................. 12

   3.8 Search results display .............................................................................................................. 12

   3.9 No Search Results ................................................................................................................... 13

   3.10 Personal Searches ................................................................................................................... 14

   3.11 Modifying a Personal Search ............................................................................................... 14

   3.12 “New Search” in Personal Searches/favourite Searches ...................................................... 16

   3.13 Shared Searches .................................................................................................................... 16

4 FOLDER CREATION ........................................................................................................................ 17

   4.1 Electronic Folders ..................................................................................................................... 17

      4.1.1 Modifying Access Controls ............................................................................................. 18

   4.2 Electronic Sub folders and User Sub Folders ......................................................................... 20

   4.3 Creating Folder Structures using “Copy Tree” Feature ......................................................... 21

      4.3.1 Set Up Step 1: Activate the “Power User Tree” ............................................................... 21

      4.3.2 Set Up Step 2: Save “Favourite Classification” .............................................................. 23
4.3.3 Set Up Step 3: Save an existing folder into Favourites to act as a Template ...........................................23
4.3.4 Create a New Folder ....................................................................................................................................24
5 NEW DOCUMENT CREATION ..........................................................................................................................27

5.1 Creating a new blank document .........................................................................................................................27
5.2 Creating a new document using a template .........................................................................................................28
5.3 Drag and Drop document saving ........................................................................................................................28
  5.3.1 Drag and Drop Multiple documents ...............................................................................................................28
  5.3.2 Drag and drop a single document ....................................................................................................................30
5.4 “Direct Save As” .................................................................................................................................................31
5.5 Saving Outlook Items ...........................................................................................................................................31
5.6 Saving email attachments only ............................................................................................................................31
  5.6.1 Direct Drag and Drop .......................................................................................................................................31
  5.6.2 Saving an open attachment (MS Office and Adobe documents only) ...............................................................32
  5.6.3 TRIM Outlook Email plug-in ........................................................................................................................32
  5.6.4 Calendar items ................................................................................................................................................33
6 NAVIGATION .........................................................................................................................................................34

6.1 Tagged Records ...................................................................................................................................................34
  6.1.1 “Tagged Records Management and Selection” Dialogue box ........................................................................34
  6.1.2 Creating a New Tag .........................................................................................................................................35
  6.1.3 Selecting an existing tag ................................................................................................................................35
6.2 Retrieving the records that have been tagged ....................................................................................................35
6.3 Modifying a Tag ..................................................................................................................................................35
6.4 In Tray ...............................................................................................................................................................36
6.5 Change Assignee ................................................................................................................................................36
  6.5.1 Change Assignee for a single folder ................................................................................................................36
  6.5.2 Change Assignee for multiple folders .............................................................................................................37
7 EDITING DOCUMENTS ..........................................................................................................................................40

7.1 Profile Screen ....................................................................................................................................................40
7.2 Right Click .........................................................................................................................................................41
7.3 Checking Out a document for editing ................................................................................................................41
7.4 Moving Documents .........................................................................................................................................42
7.5 Alternatively relating a document to a different folder ......................................................................................43
7.6 Creating a New Version of a document .............................................................................................................43
7.7 Viewing previous revisions of a document .......................................................................................................45
7.8 Viewing the Audit Log..............................................................................................................46
7.9 Attaching a Records Explorer document to an Outlook item........................................47

8 EXPORTING DATA AND THE PROJECT CONTROL CENTRE .........................................................50

8.1 Imaging and Exporting ........................................................................................................50
8.2 Project Control Centre .........................................................................................................51
  8.2.1 Change all titles to Windows Safe Characters ................................................................52
  8.2.2 Write Existing Folder structure to File System ............................................................52
  8.2.3 Write Existing Folder Structure to File System and ZIP it ........................................52
  8.2.4 Checkout Selected Folder Structure to File System ......................................................52
8.3 Project Read Only Extract Details ......................................................................................52
8.4 Sending zipped folders to clients ......................................................................................53

9 GLOSSARY ..................................................................................................................................54

10 TROUBLESHOOTING ..............................................................................................................54

10.1 Left Hand menu ...................................................................................................................54
10.2 F5 Refresh ................................................................................................................................54
10.3 Search For Records Dialogue box popping up .................................................................55
10.4 Cannot edit a document ......................................................................................................55
10.5 Document will not open when I click Edit ..........................................................................55
1  ACCESSING THE APPLICATION

Open My Computer. Records Explorer will display under your network drives.

A desktop shortcut can be created by highlighting the program name and dragging it onto the desktop.

Double Click on EFT (Records Explorer).

You will be given the following options in the right hand screen:

Double Click on USYD TRIM_Production to enter the live dataset.

You are now in Records Explorer.

NOTE: If you have any difficulties completing this step please contact Records Online immediately to have your access reviewed.

If you double click Records Explorer and there are no grey datasets listed, you will need to have the datasets configured through TRIM. A Records Online Helpdesk Officer can talk you through this on the phone, or else you can arrange for a Helpdesk Officer to come over to you and configure the datasets for you.

2  DISPLAY

Records Explorer is an interface for TRIM, the University of Sydney’s enterprise record keeping system. Records Explorer mimics the look and functionality of Windows Explorer, whilst interacting with TRIM.
2.1 FOLDERS VIEW

When launching My Computer or opening a shortcut into a Records Explorer item, if the left menu is not displayed automatically, click Organize > Folders and Search Options and ensure both ‘Navigation pane’ tick boxes are ticked. If these boxes are not ticked, your windows explorer window will resemble the screenshot below on the left (rather than the screenshot on the right).

Once you have made these changes, the drives will then be visible in the left hand column, (right screenshot).

When conducting searches or navigating to folders in Records Explorer, the options in the left hand pane can be expanded or collapsed. The core menu items are always visible if you scroll up and down, whilst the right hand side will only display your search results and the contents of folders etc.

2.2 NAVIGATION AND SEARCH OPTIONS

When the Records Explorer database is open, two search buttons will display in the top menu bar in addition to navigation options, which will be display in both the right and left hand panes.
Records Explorer navigation options / menu:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents Checked Out</td>
<td>Displays the contents of your HP Records Manager Documents Checked Out Tray i.e documents currently checked out to you.</td>
</tr>
<tr>
<td>Due/In Tray</td>
<td>Displays the contents of your HP Records Manager in Tray i.e items assigned to you</td>
</tr>
<tr>
<td>Favourite Classifications</td>
<td>A list of classifications that you have saved. Right click &gt; Add to Favourites</td>
</tr>
<tr>
<td>Favourite Locations</td>
<td>A list of locations that you have saved. Right click &gt; Add to Favourites</td>
</tr>
<tr>
<td>Favourite Records</td>
<td>A list of records that you have saved. Right click &gt; Add to Favourites</td>
</tr>
<tr>
<td>Favourite Searches</td>
<td>A list of searches that you have saved by Right click &gt; Add to Favourites</td>
</tr>
<tr>
<td>Locations</td>
<td>A list of all locations (including internal) within HP Records Manager.</td>
</tr>
<tr>
<td>My Containers</td>
<td>Displays containers you have recently accessed or created.</td>
</tr>
<tr>
<td>Personal Searches</td>
<td>Displays Saved Searches to which only you (and the HP Records Manager Administrators) have access.</td>
</tr>
<tr>
<td>Recent Documents</td>
<td>Displays the documents you have recently registered or edited.</td>
</tr>
<tr>
<td>Search Results</td>
<td>Displays the results of your last search.</td>
</tr>
<tr>
<td>Shared Searches</td>
<td>Displays saved searches to which you have access.</td>
</tr>
<tr>
<td>Tagged Records</td>
<td>Displays the records you have tagged using Records Explorer, Right Click &gt; Tag Selected Records</td>
</tr>
<tr>
<td>Work Tray</td>
<td>Displays the records you have dragged into the Work tray to work on.</td>
</tr>
</tbody>
</table>

For the majority of users these items will be empty when first using the system. They can be customised as you begin using the system. The names of any paper files that you have in your possession will appear in the In Tray and some Shared Searches may have been created on your behalf by Records Management Services.

2.3 DETAILS VIEW

As in Windows Explorer, the display for folders can be set to Thumbnails, Tile, Icons, List, or Details.

Records Management Services recommends the Details display. The Details display places the information in the right hand pane into columns allowing more information about the records to be immediately apparent. The columns can be sorted into ascending or descending order by Name, Assignee and Type etc.

In the example below the search results are sorted by Number (i.e. the TRIM Record Number):

<table>
<thead>
<tr>
<th>Name</th>
<th>Checked Out</th>
<th>Finalised</th>
<th>Number</th>
<th>Type</th>
<th>Date Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>test file created</td>
<td></td>
<td></td>
<td>115-385</td>
<td>Electronic Folder</td>
<td>2/07/2013 12:54:55 PM</td>
</tr>
<tr>
<td>Library Enquiries</td>
<td></td>
<td></td>
<td>111-305</td>
<td>Electronic Folder</td>
<td>20/01/2011 9:51:47 AM</td>
</tr>
<tr>
<td>Practice Record</td>
<td></td>
<td></td>
<td>110-3428</td>
<td>Electronic Folder</td>
<td>10/09/2010 3:41:14 PM</td>
</tr>
</tbody>
</table>
2.4 SHOW FULL PATH IN THE ADDRESS BAR

If the Windows Explorer option “Show full path in the address bar” is selected in the Windows Explorer “Folder Options”, the location of the folder that you are inside will display in the address bar. You can use this as a safeguard to know which folder you are in if you have a folder structure where the top level folder is unique but all the subfolders are a uniform for each matter.

2.5 HIGHLIGHTING MULTIPLE ITEMS IN RECORDS EXPLORER

Some functions outlined in this guide require multiple records to be highlighted.

2.5.1 ADJACENT RECORDS

Locate the required list of documents (see Section 3: Searching or Section 6: Navigation)

Click on the first document required. Hold down the Shift key and click on the bottom document required.

Click over the highlighted documents holding down the left mouse button to drag the items. Or right click over the highlighted documents to perform functions such as Tagging the records (see Section 6)

2.5.2 NON-ADJACENT RECORDS

Click on the one of the documents that you require. Hold down the CTRL key and click on the other documents that you require one-by-one.
You can now click over a highlighted document holding down the left mouse button to drag the items, or right click over the highlighted documents to perform functions such as Tagging the records (see Section 6).

**2.6 DESKTOP SHORTCUTS**

Desktop shortcuts can be made of any Records Explorer menu items, Tags, Electronic Folders, Sub Folders or Documents. Simply drag and drop to the desktop.

To open the item, double click on it. Windows Explorer will open and display the location where the item existed when you created the shortcut. The left hand pane will not open automatically when opening Records Explorer from a shortcut so click “Folders” to display the left hand pane, as outlined in Section 2.1.

When double clicking a desktop shortcut of a Document the Profile Screen will be displayed (see Section 7.1). Select the option that you require (e.g. View or Edit) and the document will open into its native application.

**2.7 OPENING NON-STANDARD DOCUMENT APPLICATIONS WITH THE TRIM DOCUMENT VIEWER**

Some non-standard document types such as Visio charts or CAD drawings will launch into the TRIM Document Viewer. The TRIM Document Viewer will only show if the document is non-standard document or if you do not have the native application installed on your desktop – this allows you to still view the document without having to install the software.

Select View > File > Launch to launch the document into its native application. This will only work if you have the relevant application installed on your machine. You cannot open a Visio chart if Visio is not installed on your machine, for instance.
3 SEARCHING

3.1 INITIATING A NEW SEARCH USING THE “RESET TRIM SEARCH” BUTTON

The Reset TRIM Search button in the menu bar will always result in a clean search being initiated (i.e. it will not inherit any filters set during a previous search): Click the Reset TRIM Search button.

The Search for Records dialogue box will then pop up:
3.2 SEARCH TAB

In the Search tab select the type of search method required and enter the relevant text. Common search methods include Title Word, Record Number, Creator, and Date Created.

Click the blue folder to the extreme right of the Search By field:

A dialogue box called Search Methods will pop up. The search methods can be displayed in categories (“Categorised”) or as a single alphabetical list (“Details”):

If using the categorised display, expand each category using the +

Select the desired search method. Click OK.

This will return you to the Search For Records screen. Enter the required text in the Equal To field:

Click OK
NB - If the Equal To field is left blank you cannot run a search – even if you have used the Filter tab to set parameters for your search.

After a search method has been used once it will then display in the drop down list in the Search By field (to the left of the blue folder icon).

3.3 BOOLEAN SEARCHING

Multiple search terms can be set by selecting New in the “Current Selection” section of the Search For Records dialogue box. Boolean searches work on the And, OR, Not principle. E.g. Creator “Bloggs, Joe”, and Title Word “Madsen” etc.

3.4 SORT TAB

Currently the Sort tab does not affect the search results. Do not use the sorting facility here – run the search, and sort the results by clicking on the appropriate column headings.

3.5 FILTER TAB

The Filter tab allows the search to be refined to only return results of a certain Record Type, Status or Disposition.

Under Disposition uncheck the relevant checkboxes to search for records that are Inactive, Destroyed or Archived

Search for finalised or unfinalised documents by selecting the relevant Finalised Filters

In the Date Registered Filter You can select broad date ranges to search within. If you need to set specific dates, use the Date Registered search option in the Search tab.
Under File Types you can type document extensions to narrow the results to a particular document type. E.g. .pdf, .docx etc

3.6 RECORD TYPES TAB

Search for specific record types by right clicking and selecting Untag All under the Record Types section.

Then, tick the record types that you do wish to search on by clicking in the white space to the left of the record type name – e.g. Electronic Folder, Document, Sub Folder. A tick will be placed next to the selected record type:

If you have not populated the Search tab please ensure that you do so before clicking OK.

3.6 MODIFYING A SEARCH USING “TRIM SEARCH” BUTTON

To correct a typo or to change some of the search parameters, select TRIM Search from the top menu bar – this will retain all of the criteria set in the previous search – including Boolean search terms and filters. Simply edit required fields and click OK to run the search again.

3.7 SEARCH RESULTS DISPLAY

The search results will display in the right hand side of the screen.
To view the contents of a folder double click on the folder name. The Sub Folders or Documents will be displayed in the right hand pane. When opening a folder from the search results it will then list under the New Search button in Favourite Searches on the left, whilst the folder contents are displayed on the right.

3.8 SEARCH PROGRESS AND COUNT

Search results do not display until all of the relevant records have been retrieved. While the search is in progress you can see the result count accumulating in the bottom left of the screen.

A final count of the number of records retrieved will then display:
3.9 NO SEARCH RESULTS

If there are no search results the following message will be displayed.

Use the TRIM Search button (See Section 3.6) to modify the search criteria.

3.10 PERSONAL SEARCHES

After running a search you are able to then save that search criteria under Personal Searches. Saving a search allows you to re-run a complex search at a later date without having to recreate all of the relevant criteria. Personal Searches will only be saved to your login.

After performing a search, expand Personal Searches to show the “New Search” option.

Right click over Search Results and select Save my Last Search:

The Select From Records dialogue will appear, listing your search results in a TRIM search screen.
Right Click over one of the documents listed in the upper pane. Select **Search > Save Search As:**

The following window will open, click **ok.**

The following window will open, **Right Click > Search > Save Search As.**

The **New Saved Search** dialogue box will appear:

**Name:** Type a title for the search so that you will recognise it later. Records Management Services recommends including an agreed **acronym** for your department as a prefix for the saved search name.

**Description** summarizes the search criteria

**Owner** will list the logged in users name.
Edit Query returns you to the Search For Records dialogue box to modify your search criteria before saving the search.

The search will now be displayed under Personal Searches:

To run a saved search, click on the search name. The Search For Records dialogue box will pop up. Click OK without making any modifications.

3.11 MODIFYING A PERSONAL SEARCH

To modify the search criteria at a later date, right click on the search name and select Edit this Search:

A dialogue box similar to the New Saved Search screen will open where you can use the Search, Filter and Access Controls tabs to modify the search criteria.

3.12 “NEW SEARCH” IN PERSONAL SEARCHES/FAVOURITE SEARCHES

By expanding Favourite Searches or Personal Searches in the left hand list options you will find that there is a New Search button. This is the same as the TRIM Search button i.e. it will inherit all the values of your most recent search including any filters that you set. If you require a fresh search use the Reset TRIM Search button on the menu bar.

3.13 SHARED SEARCHES

A Shared Search is a saved search that has been opened up for other people to view. You can share it with one other person, a whole department or any combination of people/departments provided they are registered Records Online users.

The search criteria will be the same for everyone – however, the results may vary from person to person depending on their access rights. Please bear this in mind if you are unable to view files that one of your colleagues can see. If you think that you should be able to view a file and you cannot, please notify Records Online to review your access rights.
To create a Shared Search run the search and follow the same steps as outlined in Personal Searches. Then email records_online@sydney.edu.au with the exact name of the saved search and the names of the users requiring access to the saved search, the Helpdesk will update the access controls and send you through an email notification to let you know the shared search is now available. Please then communicate this to the rest of the users in the access group.

4  FOLDER CREATION

TRIM allows users to create folder structures of three levels. For recordkeeping purposes, each of these levels has its own “Record Type”. Sub folders are subordinate to the Electronic Folder and cannot be created as a free folder – a sub folder must be contained within an Electronic Folder or else you will not be able to create it. When creating a new record for a new matter always start with an Electronic Folder and work down.

4.1 ELECTRONIC FOLDERS

To create a new Electronic Folder right click over the In Tray menu item in the left pane. Select New TRIM Record > Electronic Folder. NB - you will only see Record Types in the list that you have access to use:

A “New Record” entry form will appear. Mandatory fields are indicated by the red stars(*):

**Title:** * Descriptive title of item. This portion of the title will be returned in “Title Word” and “Notes Word” searches

**Classification:** Summary of the business process being covered by the documents inside. Often Access Controls and Retention Schedules are linked the Classification. Navigate using the blue Look-up icon.

**Owner:** * Business unit in charge of the matter the Electronic Folder covers

**Assignee:** * Individual in charge of the matter the Electronic Folder covers – not all business units use this. Generally this is used when a folder relates to a Project that is run by a single staff member.
4.1.1 MODIFYING ACCESS CONTROLS

It is recommended that Access Controls are added to the Electronic Folder so that the folder can only be viewed by relevant personnel. Only users within the Access Group will be able to see the folder and its contents. All Sub Folders and documents within the Electronic Folder will inherit these Access Controls though they can be modified after creation to restrict or open certain sub folders to a different audience.

After completing the details in the General tab, click the Update Security and Access Policy tab.

In the Access Controls pane at the bottom highlight View Metadata, and then click Custom in the bottom right:

![Customise Access - View Metadata dialogue box]

In the Customise Access – View Metadata dialogue box:

- Select Restricted to the following Locations (and any of their members).
- Highlight your own name in the Sort Name field and select Remove.
- Then select Add.

A list of all locations will appear.
Simply start typing the name of the business unit, or individual’s surname, the **Prefix Search – Name** dialogue box will appear with your text inserted, place an asterisk (*)&#42; at the end of the word and hit **Enter/Click OK**.

All locations that begin with that word will appear in a list.

Select the relevant location and click **OK**.

This will return you to the **Customise Access – View Metadata** dialogue box. Repeat this step if more users or business units are required to have access. Click **OK**.

You are now back in the **New Electronic Folder** dialogue box. Click **OK**.

Upon creation a dialogue box will pop up:

Selecting **Yes** will then expand the **My Containers** menu item in the left pane and the new folder will be listed alphabetically. It will be highlighted.
Double click on the folder to open it and begin adding documents (see Sections 5), or to add Sub Folders (see Section 4.2).

If Records Online Helpdesk normally populate the Sub Folders and User Sub Folders for you, continue creating all of the Electronic Folders you need then send an email to records.online@sydney.edu.au asking for the sub folders to be populated for all Electronic Folders created by yourself and the date of creation.

4.2 ELECTRONIC SUB FOLDERS AND USER SUB FOLDERS

To create a Sub Folder within an existing Electronic Folder, open the existing folder, or highlight it, and right click > New TRIM Record > Sub Folder

The New Record entry form will pop up:

Generally, just complete the Title (Free Text Part) field and click Ok. Most other fields are inherited directly from the parent container – i.e. the Electronic Folder – and cannot be modified.

A different Retention Schedule can be applied to the Sub Folder. Sub Folders may need to be kept for different lengths of time. Refer to the folder structure outlined by Records Management Services and your department.
Creating a User Sub folder is performed in exactly the same way as above. The User Sub Folder is the third and final level in the TRIM folder structure.

4.3 CREATING FOLDER STRUCTURES USING “COPY TREE” FEATURE

A New Electronic Folder complete with the sub folder structure can be generated by Copying an existing folder. The structure is then Pasted on to the relevant Classification Node. (Generally RMS will have prescribed this Classification to your team as part of Records Explorer training.)

RMS recommends that you follow these 3 steps upon first for the best experience:

4.3.1 SET UP STEP 1: ACTIVATE THE “POWER USER TREE”

In the Menu Bar, select TRIM User Settings > Activate Power User Tree View:

If when opening Records Explorer you are presented with the following view (i.e. No TRIM User Settings)

To fix this simply click on Organize at the top of the page

Open Folder and search options
Open the View Tab - Tick *Always show menus* – Click Apply & OK.

This will show the top menu bar

In the Menu Bar, select TRIM User Settings > Activate Power User Tree View:

Press F5 to refresh the screen.

The menu should change showing more menu items than previously – in particular you need to see “Browse Via Classifications” and “Favourite Classifications”.

If the menu does not refresh, try closing Records Explorer and re-opening.
4.3.2 SET UP STEP 2: SAVE “FAVOURITE CLASSIFICATION”

In the left-hand pane, click on the Browse Via Classification menu option.

Navigate through the Classification Tree to the Classification used for your departments Folder Structure e.g. Administration & Support – Property Management – Extension & Refurbishment

When you see the final tier of the Classification you need (in this example “Extension & Refurbishment”) Right Click on it > Add to Favourites:

![Classification Tree Example]

The Classification will now show in Favourite Classifications as a shortcut

![Favourite Classifications]

**TIP:** Left Click will reveal all Administrative Files and Electronic Folder that have been created under this Classification – this may be a vast number of records and could take a long time to extract). Avoid left clicking on the last tier of a classification if at all possible

4.3.3 SET UP STEP 3: SAVE AN EXISTING FOLDER INTO FAVOURITES TO ACT AS A TEMPLATE

Locate an Electronic Folder that has the Folder Structure required for your department’s files – Try your In Tray or My Containers, or else conduct a TRIM Search. Right Click on the Folder > Add to Favourites.

If you wish to make a proper template folder rather than just copying an existing folder that is in use, this is possible.
You can create a template yourself using the copy tree feature. Otherwise, ask Records Online Helpdesk to create one. They will send you the Record Number to allow you to search for the record. Supply the Record Number of the template folder to any of your colleagues who do Folder Creation so that there is only one template in use.

4.3.4 CREATE A NEW FOLDER

Go to Favourite Records to see the Template Folder (as saved at step 4.3.3 above)

Right Click on the Folder > New TRIM Record > Copy Folder (s) and Sub Folders: [Record Number]

A confirmation message will appear, Click OK:

Go to Favourite Classifications.

Right Click on the saved Classification (as per step 4.3.1 above) > New TRIM Record > Paste Folders and Sub Folders: [Record Number]
A Paste Folder Structure dialogue box will pop up showing all Folders, Sub Folders, User Sub Folders and Documents from the Template folder.

NB - By default, the Copy Tree feature selects all Folders, Sub Folders and User Subfolders for copying, but leaves all documents unselected. If you wish to copy documents as well, either place a tick next to specific documents that you require or to copy all documents click the “Select All Electronic Records option” at the bottom of screen.

Scroll to the top of the dialogue box to see the Folder Title. Right Click on it > Edit Title

A small dialogue box Edit Title will pop up. Type the new Folder title over the top of the original folder’s title, Click OK:

The Edit Title dialogue box will close and the Title of the record in the Paste Folder Structure screen will update.

Ensure that Copy Electronic Files along with the Record (at the bottom of the dialogue box) is selected.

Click Create Copies
In the **Folder Copy and Paste Interaction Methods**, select **Automatic**.

**TIP:** if you realised at this point that you had forgotten to change the Folder Title, you could select **Partial** and modify the title in the Folder Properties screen. **Never** select **Interactive** as you will need to OK a multitude of properties screens.

As the tool works, each Folder will have `[Created]` appended to the folder title in the **Paste Folder Structure** screen (this is not in the actual folder title – it is just to show the progress of folder creation).

Scroll to the bottom of the **Paste Folder Structure** Screen.

Once the last Folder says “Created”, simply click **Close** to the **Paste Folder Structure** screen.

The new Folder can be located in **My Containers**.
5 NEW DOCUMENT CREATION

5.1 CREATING A NEW BLANK DOCUMENT

Locate the Folder / Sub Folder where you wish to save a new document.

Right Click > Create New Document > (Select appropriate document type)

The New Record Document dialogue box will appear:

Enter a document title, following naming conventions outlined by your department. **This is mandatory**

Write your surname in the **Author** field then select the blue folder look-up, to pick your name from the list of users with the same surname. This will appear in the drop down list for subsequent records that you create.

The **Container** shows the Record Number of the folder you are placing the document inside. This is mandatory but will auto-populate provided you initiated the New Document creation by right clicking on or inside the desired folder.

Click **OK**.

Then you will receive the following message:

Select **Yes** to launch the blank document/template and begin editing.

If you select **No** and wish to work on the document later, it can be found in the appropriate folder or under **Recent Records**.
5.2 **CREATING A NEW DOCUMENT USING A TEMPLATE**

To create a document using one of your business units templates, right click > **Create New Document > Choose From Office Templates**. In the **Please Select a File** screen, click on My Computer and navigate through your network drives to the stored template.

To locate other Microsoft Office applications navigate through your C:Drive to the following path:

5.3 **DRAG AND DROP DOCUMENT SAVING**

5.3.1 **DRAG AND DROP MULTIPLE DOCUMENTS**

Open your network drive in a new window. Locate the required documents and highlight them using the Shift or Ctrl keys (for further instructions see **Section 2.4**).

Click on the highlighted area, hold down the left mouse button and drag the documents over to the relevant folder in Records Explorer. Release the mouse button.

When you release the mouse the following screen will appear:
NB - If the Default Record Type will be box is not present please contact Records Online Helpdesk so they can talk you through adding this.

Click in the check boxes to select the desired functions. The Drag and Drop Options are defined in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create HP TRIM TR5 Reference in Source File Folder</strong></td>
<td>Saves the document to Records Explorer, and leaves a link to the document in the source directory.</td>
</tr>
<tr>
<td><strong>Carry forward Record Type, Container, User Fields and Various TRIM Fields</strong></td>
<td>Useful for dragging multiple documents. The Record Type, Container and some other generic fields for the documents in that drag and drop will be copied over. <strong>Always leave this option checked.</strong></td>
</tr>
<tr>
<td><strong>Attempt to store all files after first one without user interaction</strong></td>
<td>Again, when dragging multiple documents, only one New Record Document form will need to be completed, the others will be uploaded automatically. This feature works in conjunction with the option above.</td>
</tr>
<tr>
<td><strong>Delete Original Files after saving to HP TRIM</strong></td>
<td>Original documents from your network drives will be automatically deleted after saving them to Records Explorer.</td>
</tr>
<tr>
<td><strong>Re-sequence Titles after Save</strong></td>
<td>When doing a bulk drag and drop of documents, a description can be added to all titles – e.g. if you have 10 photos of the Main Quad that are named IMG0001 through IMG0010, you could append “Main Quad Photos 2011010” to all ten photos. You can also completely replace the original title if desired. A numbering pattern can also be allocated by the Title Sequencer such as “1 of 10, 2 of 10... 10 of 10” to represent this relationship.</td>
</tr>
</tbody>
</table>

After the documents are saved an additional dialogue box will appear:
Select from the **Title Formats** at the bottom how you would like the numbers to display. Select **Apply**.
Click **Yes** to the following warning:

Click **Save**. A New Record Document form will appear as per Section 5.1.

The **Title** is inherited from the title in your network drive, it can be edited within this screen if desired; the **Container** populated with the record number of the folder that you dragged the document into.

A second dialogue box will also be present in the top of the screen called **Progress of Bulk Storage Operation**. This will show the progress of the documents being saved. It will disappear when all of the documents have been catalogued.

Click **OK**.

**5.3.2 DRAG AND DROP A SINGLE DOCUMENT**
For a single document, highlight the required document and drag and drop to the relevant Records Explorer folder.

The Drag and Drop Options dialogue box will pop-up. All of the drag and drop options except “Attempt to store all...” will have the same affect for a single document as a multiple document drag and drop. Click Save.

A New Record Document form will appear. Alter the title, author etc if desired. Click OK.

5.4 “DIRECT SAVE AS”

It is possible in the HP TRIM 7 release of Records Explorer to save a MS Office or Adobe document directly to Records Explorer in the normal Windows Explorer way.

However, please ensure that the folder that you wish to save the document into is available under Tagged Records, Favourite Records or In Tray as you will not be able to conduct a search once in the “Save As” process.

With the document open, select Save As > Word Document (for example)> My Computer > Records Explorer > USYD_TRIM_Production and then navigate through to the required folder. Click Open.

Upon saving the New Record entry form will display. Complete the title and save. The document will remain checked out for editing until it is has been closed.

5.5 SAVING OUTLOOK ITEMS

Outlook items can be saved using drag and drop, as per a document from your network drive. They can also be dragged over in bulk by highlighting all relevant emails and dragging into Records Explorer.

The Bulk Email Storage Options box will pop-up:

Always leave Carry forward the selected Record Type checked.

Check Only show data entry screen for first item stored so that a New Record Form will display for one item only; all subsequent items will be stored without need of your interaction.

If dragging a large portion of emails over at once, the screen may freeze while this is in progress. There is no “Progress of bulk email storage operation” dialogue box as there is when dragging documents from the network folders. Progress can be monitored by the appending of the words “TRIMDB:US” in front of the email subject line as the email is successfully catalogued. RMS recommends limiting the number of emails being dragged over in a single drag and drop to a maximum of 50 at a time. You will be able to distinguish catalogued emails from uncatalogued emails by “TRIMDB:US” appearing in front of the email subject line.

5.6 SAVING EMAIL ATTACHMENTS ONLY

5.6.1 DIRECT DRAG AND DROP
In the HP TRIM 7 version of Records Explorer direct drag and drop of email attachments has been enabled.

Highlight the attachments and drag them to the appropriate folder in Records Explorer. Let go of the mouse button. The Drag and Drop options will pop up the same as if you had dragged these documents from the network drive (See Section 5.2). If you have dragged multiple documents over then, use the “Attempt to store all after the first one without user interaction” button. Click Save. The bulk progress bar will display while the attachments are being logged to TRIM.

### 5.6.2 SAVING AN OPEN ATTACHMENT (MS OFFICE AND ADOBE DOCUMENTS ONLY)

If the attachment is open and is a MS office or Adobe document, then select **Save As > My Computer > Records Explorer** and navigate through to the correct folder. (As per Section 5.4)

### 5.6.3 TRIM OUTLOOK EMAIL PLUG-IN

With Drag and Drop enabled this tool is not particularly necessary – however, if you have a simple folder structure you may wish to map your outlook folders to matching Records Explorer folders if the bulk of your documentation is in email format.

In your Outlook you will see the ‘HP Records Manager’ tab on your tool bar:

Take note of the Record Number for the folder you wish to map to. (Note: you can title your outlook folder as you wish. In this case, ‘test’ has been used for demonstration purposes.)

Highlight the folder in your Outlook Inbox.

Select the **Create Link** button

A **TRIM Folder Properties** dialogue box will pop up:
It is recommended that you leave **Display data entry form when cataloguing messages** ticked. (Occasionally if Outlook does not close properly the HP Records Manager add-in will disappear and needs to be reinstated from the Disabled Items. You will know that this has happened immediately if you drag an email into a mapped folder and the New Record dialogue box does not pop up.)

Click **OK**.

You can now drag emails into that Outlook folder and they will be catalogued into TRIM. The word TRIM will be added as a prefix to the Email subject line as a further indication that the document has been saved.

### 5.6.4 CALENDAR ITEMS

Presently Records Explorer cannot support calendar items that are dragged directly from Outlook. If you wish to save these document types please save them to your network drive/desktop in **iCalendar Format** (.ics extension)

Then save it into Records Explorer using Drag and Drop as you would any other document stored in your network drive. This will allow you to open the document and launch it into its original format to see all the contextual information such as attendees.
6 NAVIGATION

6.1 TAGGED RECORDS

Tagging records allows you to group together records that may not otherwise be related. Tagged Records lists are personal and can only be viewed by you.

Run a search for folders or documents that you would like to tag, or perform this task after creating of a new record.

6.1.1 “TAGGED RECORDS MANAGEMENT AND SELECTION” DIALOGUE BOX

Select the records that you want to tag from the search results. (To highlight multiple records follow the instructions in Section 2.4.)

Right Click on the text block and select Tag Selected Records

The Tagged Records Management and Selection dialogue box will pop up:

This will be blank when you first start using Records Explorer. (See Section 6.1.2 for creating a new tag. See Section 6.1.3 for how to select an existing tag.)

As your tag list become long, or if the tag names are lengthy, the scroll bars will allow you to see the full list/tag name.
6.1.2 CREATING A NEW TAG

To create a new tag, type the name under **New Tag Name** in the bottom of the Tagged Records Management and Selection dialogue box and click **Create**. The tag will then be added to the **My Record Tags** list.

To use the tag, highlight it and click **Use this one**.

The new tag will now appear under the Tagged Records menu item.

6.1.3 SELECTING AN EXISTING TAG

Once a tag has been created you can simply **drag** new documents or folders **over the tag and drop**.

You will receive a dialogue box to confirm that you wish to tag the records. Then a confirmation that the record has in fact been tagged.

You can also right click on the record you wish to tag > **Tag Selected Records** and select the relevant tag from your My Record Tags list. Click **Use this one**.

6.2 RETRIEVING THE RECORDS THAT HAVE BEEN TAGGED

Expand the Tagged Records option in the left pane list.

Double click on the tag name to open up a list of all of the tagged records in that tag.

![Tagged Records](image)

Tagged Records, or individual tags can be dragged to the desktop as a shortcut if desired.

6.3 MODIFYING A TAG

Tags can be deleted, but cannot be renamed. Deleting a tag does not affect the records within, they still exist.

To delete a tag, right click on the relevant tag and select **Manage my Tag Groups**:

![Manage my Tag Groups](image)

Highlight the required tag and select **Delete**.

If you wished to change the name of the tag and retain all the tagged records, first create the new tag name.

Open the existing tag, highlight all the records, left mouse click on the records and drag them to the new tag.

Then, delete the old tag.
6.4 IN TRAY

The **In Tray** is located in the menu options and is populated with folders that have been assigned to you. Double click on the **In Tray** to view its contents:

![In Tray screenshot]

The In Tray will hold folders and paper files that have you as the “assignee”. This form of navigation is not used by most business units as most matters have multiple people contributing to the record keeping. You may not have any records in your In Tray, this is normal.

Assignee is only set against a top level Electronic Folder. Sub Folders and Documents are considered to be “Contained in” the top level folder.

6.5 CHANGE ASSIGNEE

6.5.1 CHANGE ASSIGNEE FOR A SINGLE FOLDER

If a project has been reassigned to another officer, the Assignee can be changed by navigating to the appropriate Electronic Folder and Right Click > **Show Properties and Data > Record Properties**

![Record Properties screenshot]

Select the blue look-up folder to the right of the **Assignee** field:

![Assignee field screenshot]

The **Select From Locations** dialogue box will pop up with the current Assignee listed. Simply begin typing the surname of the new Assignee. The **Prefix Search – Name** dialogue box will appear. Hit **Enter** / click **OK**.
A list of all people with surnames beginning with those letters will appear. Select the appropriate person from the list. Click OK.

This will return you to the Properties screen. Click OK.

The Assignee is now changed. The folder will now appear in the In Tray of the new Assignee and will no longer be in the In Tray of the previous Assignee. The folder is still searchable and accessible by all relevant parties.

### 6.5.2 CHANGE ASSIGNEE FOR MULTIPLE FOLDERS

To change the Assignee for a large number of folders, navigate to the appropriate folders via a search, a tag, your own In Tray etc. Highlight all of the relevant folders by following the instructions in Section 2.4. Right Click > Show Properties and Data > Show in Search Screen:

The Select From Records dialogue box will pop-up listing the selected folders. Right Click > Tag All:
A tick will appear next to all of the Folders. Right Click > **Locations** > **Assignee**

The **Set Assignee** dialogue box will appear.

Ensure that **All Tagged Rows** is selected.

Click **OK**.

In the **Set Assignee – All Tagged Rows** dialogue box
Select the blue look-up folder to the right of the Set to Location field

The Select From Locations dialogue box will appear. Begin typing the surname of the new Assignee (see Section 6.7.1 for detail). Click OK.

Select the correct user from the resulting list and Click OK.

In the Set Assignee dialogue box, click OK.

Select Yes To All

When the Set Assignee dialogue box disappears your list of folders will be displayed and the Assignee will reflect the changes:
Close the dialogue box and return to Records Explorer, which will still be open in your task bar.

The folders will now be reassigned and will now appear in the In Tray of the new assignee.

7 EDITING DOCUMENTS

7.1 PROFILE SCREEN

Double clicking on a document opens up the Profile Screen. Select what you want to do with the document:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td>Opens a Read-Only copy.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Opens a copy that can be altered. Upon saving and closing the document it will be checked back into Records Explorer as a new revision (see Section 6.4).</td>
</tr>
<tr>
<td><strong>Details</strong></td>
<td>Select to view the metadata of the document (i.e. the Title, Retention Schedule, Assignee etc)</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Select to see an editable version of the metadata</td>
</tr>
<tr>
<td><strong>Checkin</strong></td>
<td>This option will only be available if the document you have selected is currently checked out to you.</td>
</tr>
<tr>
<td><strong>Finalise</strong></td>
<td>Locks the document so that it becomes Read-Only and can no longer be opened for editing by users. If at a later date a revision needs to be made you can create a new version (see Section 6.3) and make changes to that document, which will be related to the first document as [v1] and [v2] etc.</td>
</tr>
<tr>
<td><strong>Update Typed Title</strong></td>
<td>Allows you to make changes to the document title. Enter the changes to the title and then click the Update Typed Title button.</td>
</tr>
</tbody>
</table>

### 7.2 RIGHT CLICK

Rather than double clicking and using the Profile Screen you can also **Right Click** on a document and select:

> Advanced > Check Out and Edit

> View Document

> Show in Context (you can then Right Click > Electronic > Final)

> Edit Properties (Click the revisions tab to see previous revisions of the document)

### 7.3 CHECKING OUT A DOCUMENT FOR EDITING

To edit a document you must “check it out” of Records Explorer. When you check it out it will be saved into your My Documents under a folder called “Offline Records” with the same red and blue X that characterises Records Explorer. Upon saving the edited document it will be checked back into Records Explorer as a new revision under the same name, record number etc.

To check out a document double click on the document name. The **Profile Screen** will appear:
Select the **Edit** option. The document will launch in its native application. See **Section 2.7** if this does not happen automatically.

Edit the document and click Save as normal. Then close the document. The document is now checked in. There can be some delay between closing a document and Records Explorer recognising that the document is checked back in. Before you close your Records Explorer session open the **My Checked Out Documents** menu item. This should be empty. If not, double click on the document and select the **Checkin** option from the Profile Screen.

You can hit CTRL+S or Save in Word (etc) as many times as you like whilst you are working on the document, a new revision will only be created in Records Explorer once you have closed the document at the end/checked it back in.

When opening Records Explorer for the first time each day you will receive a message if there are any documents Checked Out to you. You will not receive any message if there are no documents Checked Out.

### 7.4 MOVING DOCUMENTS

If you have placed a document in the wrong folder you can move it to another folder by drag and drop.

First locate the new folder. Ensure that you can see one folder in the right hand pane and one in the left – use favourites or tags to group ensure they display adequately. Open the folder that currently contains the document

Drag and drop the document onto the correct folder:

Select **Move these Record to the Container**
You will receive a confirmation that the move was successful. Click OK.

If you ever receive this screen in error – by dragging and dropping accidently – simply click Quit to close the dialogue box without taking any action.

7.5 ALTERNATIVELY RELATING A DOCUMENT TO A DIFFERENT FOLDER

It is possible for a single document to be displayed in two or more folders if needed. In TRIM this is referred to as an “Alternative Relationship” or “Alternatively Contained Within”. This is similar to creating a shortcut.

To effect this, simply drag and drop the document from its original place to whichever folder it needs to be displayed in as well. When the Drag Drop Options dialogue box pop-up select Alternatively Relate These Records to the Container.

You will receive a confirmation that the relationship was successfully established. The document will now be displayed in both folders. Any modifications made to the document will be reflected in both spots – this is one document, the alternative relationship is much like a shortcut.

7.6 CREATING A NEW VERSION OF A DOCUMENT

If you need to make a new version of a document to distinguish it from its present state, locate the document that you wish to create a new version of. Right Click on the Document name, select Advanced > Create New Version.

The following dialogue box will appear. The greyed out fields will be inherited automatically, you can customise what other aspects of the original record you want the new version to inherit. Records Management Services recommends that you do not change any of the defaults:
If you have already begun drafting the New Version of the document and it is saved in your network drives tick the **Use the following document to start off the new version** check box at the bottom, the field below it will then become active and the document icon at the far right can be clicked to start a Browse.

Locate the document in your drives and click **Open**. Then click **OK** in the original dialogue box.

If you do not have a working draft, skip the above step and simply click **OK**. The New Version will be a direct copy of the original until you open it and make changes.

The two versions will have [v1] and [v2] appended to the title. They will also have the same record number but with [v1] and [v2] appended to the Record Number.
It is best practice to then **Finalise** the original document so that it can no longer be edited. Double Click on the document with [v1] appended to the title. Select **Finalise** from the Profile Screen.

If the new version of the document needs to be placed into a different folder, move the document as in **Section 7.3**

### 7.7 VIEWING PREVIOUS REVISIONS OF A DOCUMENT

Each time a document is checked out, changes are made and the document is checked back in, Records Explorer saves a new revision and keeps the old copy in the background. To access the previous Revisions, right click on the document > **Show Properties and Data** > **Show Revisions**.

If there are revisions the “Select from Revisions” dialogue box will show. **NB – If after 5 seconds no screen has popped up it is safe to assume that the document has never been modified (since being in TRIM) and that therefore no revisions exist.**

You can then select from the list of revisions.

1. **Right Click** > **View** (to see the document)
2. Right Click > Extract (to save a copy to your local drives).
3. Right Click > Print Document.

If the document opens in the TRIM Document Viewer rather than its native format (e.g. Microsoft Word, Microsoft Excel etc) click File > Launch and it will launch into the native format. (See Section 2.7 for further details about the TRIM Document Viewer)

7.8 VIEWING THE AUDIT LOG

Each time a person makes a modification on a folder or document this activity is recorded in the Active Audit Events against their unikey login.

Locate the document/folder. Right Click > Show Properties and Data > Show History

Select/tag the folder or document you wish to view the active audit events for. Right Click > Security and Audit > Active Audit Events
The Active Audit Events will then display with the activity performed listed under **Event**, the unikey of the person who performed the activity under **Login**, plus the **Event Date** of the activity and some further context listed under the **Event Details**:

### 7.9 ATTACHING A RECORDS EXPLORER DOCUMENT TO AN OUTLOOK ITEM

This function is only supported for Outlook at the present time, not for other email clients such as Entourage.

Locate the document in Records Explorer.

Right click on the document name > **Advanced** > **Send Email via Outlook**
The following dialogue box will appear:

Select the Mail Item Type you desire – Email, Appointment or Task – on the left.

On the right are three options for the attachment format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach As TRIM References</td>
<td>Provides the recipient with a link to the document in TRIM Desktop. The recipient will only be able to open the document if they are a registered user with Records Management Services and they have sufficient access rights to view your documents. Sending a link to a colleague allows them to check the document out and edit it, check it back in and all the work automatically captured into TRIM.</td>
</tr>
<tr>
<td>Attach As Real Electronic Document</td>
<td>Provides the recipient with a normal attachment in its native application (e.g. Excel or Word). This provides no security measure on who can open the document. If the person makes any revisions to the document they will not be captured into TRIM unless this is conducted manually.</td>
</tr>
<tr>
<td>Use Both Methods</td>
<td>This can provide the recipient with a link to the document in TRIM if editing is required, it can also provide them with a native copy of the document if they need to send it on to a third party or do not wish to make any changes to the document but would still like to know where the document is located in TRIM. This is also useful if you are not sure if multiple recipients are</td>
</tr>
</tbody>
</table>
Records Explorer users.

The attachments will appear with the Document Number and the first 50 characters of the title in the file name. The full details will be listed in the body of the email as per the Windows Explorer feature “Send to > Mail Recipient”. You may notice the email signature does not appear automatically; this too, is in keeping with the Windows Explorer Send to Mail Recipient behaviour.

To attach documents to an email reply, generate a new email as per above and then copy the documents from the new email over to the email reply.

Alternatively, if you have the TRIM plug-in activated in your Outlook you can click on the HP TRIM tab in the email and select Attach Records:

You then need to search for the documents you wish to attach.

If you need to navigate through the folders in your In Tray or Favourite, click into the blue look up folder and navigate in “details” view to the Records In-Tray. Highlight it and click Ok.

Click Ok to the search for records screen.

In the Select From Records – Records In-Tray dialogue box, the folders from your In Tray will be displayed.

Expand the folders to see the documents inside.

Select a document by clicking in the white space to the left and placing a purple tick.
Click OK.

The Attach HP TRIM Records dialogue box will pop up.

You can deselect any documents you have changed your mind about including if desired.

Ensure that Attach Electronic Document is selected in the bottom 3 options.

You can select the other options if desired:

Add Record Details to Message Body will place a summary of document metadata into the email body.

Attach HP TRIM Record Reference will insert a TRIM link for each document into the attachments section of the email, so if you are attaching 3 documents, you will have 3 documents and 3 links, equalling 6 attachments in total.

Use the searching section of this manual to locate documents using other search methods. You will probably need to use Boolean searches and filter the search down so that TRIM is only searching for the “Document” record type.

When using this feature it is best to complete the whole process without navigating away, if you do navigate away or try to go back a step often the search screen will go behind other windows that you have open and can be difficult to get back to the forefront again.

8  EXPORTING DATA AND THE PROJECT CONTROL CENTRE

Please talk to the Records Online helpdesk or you Records Management Services Project Officer for advice before using these features.

8.1  IMAGING AND EXPORTING
You may need to remove documents from TRIM in bulk in order to send them on to external clients etc. If all are located in a single subfolder, simply highlight the necessary documents > Right Click > Imaging and Exporting. (this will be in the Advanced menu if you only select a single document to export).

Select what versions of the documents you wish to export – this is defaulted to the Latest edits. TRIM is currently not supporting Thumbnails so please ignore these options.

Select Apply

You will need to pick a place to save the documents – i.e. the Desktop or My Documents

Click ok.

8.2 PROJECT CONTROL CENTRE

You can only export one folder structure at a time. However, if you have an Electronic Folder and alternatively contain multiple folders inside that Folder, the alternative contents then act like sub folders to the top folder allowing you to export multiple folders in one action.
Please ensure that the Top Folder has a short title, a maximum of 40 characters, if you wish to send the extracted file off as a large file transfer through the University’s web page. An additional 8 characters will be added to the title upon extraction which will bring the title up to its limit of 50 characters.

8.2.1 CHANGE ALL TITLES TO WINDOWS SAFE CHARACTERS

This feature only affects one layer of the folder structure. You need to go into each sub folder to make the characters of documents within safe. The best method therefore is to make them safe upon saving – please minimise all punctuation and characters in titles.

Please save items without unsafe characters including FW: or RE: in email headers. Any documents with unsafe characters will not be extracted.

8.2.2 WRITE EXISTING FOLDER STRUCTURE TO FILE SYSTEM

This will create a normal windows folder that mimics the structure you just extracted. Only folders / sub folders with contents will be extracted. Empty folders will not be included.

Right click on the electronic folder required > Project Control Centre > Write Selected Folder Structure to File System

This process (and those outlined in 8.2.3 and 8.2.4) may take several minutes depending on the size of the items you are extracting. Please leave it alone while it is processing. You can still work on other non-Windows Explorer applications including Outlook, Internet Explorer, Filemaker Pro and TRIM Context in its native format.

When it is complete the location of the folder will display in a Windows Explorer page. Minimise this to see the report of documents extracted. See Section 8.3 for more details

8.2.3 WRITE EXISTING FOLDER STRUCTURE TO FILE SYSTEM AND ZIP IT

Follow the steps in Section 8.2.2 but select the option with “and ZIP it”. This will produce both a normal windows folder and a zipped folder being extracted.

8.2.4 CHECKOUT SELECTED FOLDER STRUCTURE TO FILE SYSTEM

This feature extracts the files into a normal Windows folder, however all of the documents inside will be checked out to you as though you are editing them. This is not recommended unless used in a controlled environment.

8.3 PROJECT READ ONLY EXTRACTION DETAILS
Records Explorer Manual

Once the extraction is complete and the Desktop pops-up in a Windows folder, a report of the documents extracted will be displayed. If you click back into Records Explorer you will see a report of the documents that were exported.

Any that read “Could Not Extract” will not be present in the extracted folder. Generally this will only happen to documents that have titles with “unsafe characters”. If there are any documents that did not extract which have entirely windows safe characters please contact RMS to investigate the reasons.

It is possible to export the remaining document(s) by locating them in the TRIM folder and following the steps in 8.1 for Imaging and Exporting. Once saved, drag the document into the folder structure you had extracted previously. This will work for zipped folders as well.

8.4 SENDING ZIPPED FOLDERS TO CLIENTS

If you send the zipped folder to a client, please ask them to “Extract All files” before viewing the documents inside as this will ensure that the documents will open. Occasionally a document exported from TRIM in this Export and Zip action will not open directly from the zipped folder and extraction will solve this issue.
9 GLOSSARY

<table>
<thead>
<tr>
<th>TERM</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRIM</td>
<td>The program for which Records Explorer is an interface. Also referred to as <strong>HP TRIM</strong> in the Drag and Drop Options.</td>
</tr>
<tr>
<td>Record</td>
<td>Any evidence of a business transaction tacking place – an email, memo, tender, letter, meeting minutes etc.</td>
</tr>
<tr>
<td>Folder</td>
<td>Much the same as a Windows Explorer folder, though with additional metadata. Used in this guide as an abbreviation of the following*:</td>
</tr>
<tr>
<td>*Electronic Folder</td>
<td>Refers to the top level folder in the structure, Electronic Folder is the name used in TRIM. This is where the summary of the project is recorded. Documents should not be added at this level.</td>
</tr>
<tr>
<td>*Sub Folder</td>
<td>Second layer of the folder structure; Sub Folders are contained within an Electronic Folder. Documents can be added at this level if there are no User Sub Folders within.</td>
</tr>
<tr>
<td>*User Sub Folder</td>
<td>Third layer of the folder structure; Documents should always be added at this level unless no User Sub Folders exist. “User Sub Folder” is the name used in TRIM, it has a pink icon.</td>
</tr>
<tr>
<td>Document</td>
<td>The form that a record takes – Microsoft Office applications, CAD, Outlook items etc.</td>
</tr>
<tr>
<td>Container</td>
<td>Folder in which a Sub Folder or document is stored.</td>
</tr>
<tr>
<td>[Blue] Look-up folder</td>
<td>Contains different features depending on where the look-up is located, click on the look up to make selections.</td>
</tr>
</tbody>
</table>

10 TROUBLESHOOTING

10.1 LEFT HAND MENU

The left hand list pane displays a selection of your search results. Do not be alarmed if this does not refresh at the same speed as the right hand view. You can Right Click > Refresh Folder to force a refresh. Some features in the left hand pane will only refresh after you have closed the application.

10.2 F5 REFRESH
If you are refreshing in order to see “Checked Out” update and it is causing the “Search For Records” to pop up, instead wait till later in the session and check under “My Checked Out Documents” instead. If they are still “Checked Out” ensure that all documents are closed and use the Profile Screen (double click) or Right Click > Advanced > Check In.

10.3 SEARCH FOR RECORDS DIALOGUE BOX POPPING UP

This happens occasionally on an F5 refresh particularly in the Shared/Saved Searches functions. Records Management Services aim to improve this functionality on the next release. Try clicking out of the folder and then back into it again rather than using the F5 button to refresh the screen. This should update the view.

10.4 CANNOT EDIT A DOCUMENT

Is it finalised? If yes, it cannot be edited. You should create a New Version and make changes to that.

Is it checked out to someone else? If so, ask that person to check it back in so that you can make changes.

10.5 DOCUMENT WILL NOT OPEN WHEN I CLICK EDIT

You can only open a document for edit if you have the application installed on your PC. e.g. if you wish to open a CAD document you must have the compatible software installed on your computer or else you can only see a Read-Only version in the TRIM Document Viewer. You may receive the following message:

It may also try to launch Internet Explorer, to direct you to the software.